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Technical Support

If you have difficulties using Dial Dictate please read the applicable topic before requesting 
support. If your problem is not covered in this user guide please view the up-to-date Dial 
Dictate Online Technical Support at www.nch.com.au/dialdictate/support.html . 
If that does not solve your problem, you can contact us using the technical support contacts 
listed on that page.

Software Suggestions

If you have any suggestions for improvements to Dial Dictate, or suggestions for other related 
software that you might need, please post it on our Suggestions page at 
www.nch.com.au/suggestions/index.html

. 
Many of our software projects have been undertaken after suggestions from users like you. 
You get a free upgrade if we follow your suggestion.

www.nch.com.au/dialdictate/support.html
www.nch.com.au/suggestions/index.html
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Software License Terms

1.  The copyrights in this software and any visual or audio work distributed with the software 
belong to NCH Software and others listed in the about box. All rights are reserved. 
Installation of this software and any software bundled with or installed-on-demand from this 
software is licensed only in accordance with these terms.

2.  By installing, using or distributing this software you, on your own behalf and on behalf of 
your employer or principal, agree to be bound by these terms. If you do not agree to any of 
these terms, you may not use, copy, transmit, distribute, nor install this software - return it 
to the place of purchase within 14 days to receive a full refund.

3.  This software, and all accompanying files, data and materials, are distributed "as is" and 
with no warranties of any kind, whether express or implied except as required by law. If you 
intend to rely on this software for critical purposes you must test it fully prior to using it, 
install redundant systems and assume any risk.

4.  We will not be liable for any loss arising out of the use of this software including, but not 
limited to, any special, incidental or consequential loss. Your entire remedy against us for 
all claims is limited to receiving a full refund for the amount you paid for the software.

5.  You may not use this software in any circumstances where there is any risk that failure of 
this software might result in a physical injury or loss of life. You agree to indemnify us from 
any claims relating to such unauthorized use.

6.  You may copy or distribute the installation file of this software in its complete unaltered 
form but you may not, under any circumstances, distribute any software registration code 
for any of our programs without written permission. In the event that you do distribute a 
software registration code, you will be liable to pay the full purchase price for each location 
where the unauthorized use occurs.

7.  Use of statistics collected by the software is subject to the NCH Software Privacy 
Statement which allows automatic anonymized collection of usage statistics in limited 
circumstances.

8.  The contract arising out of this agreement is governed by the laws and courts of the 
Australian Capital Territory.

3



Contents - Overview

DialDictate lets you dictate by telephone.

You, and other users, dial into a computer running DialDictate to record dictation. Recording, 
replay, editing and file management are controlled by pressing numbers on your telephone 
keypad. When you have completed a recording, DialDictate can then send immediately the 
dictation for transcription by email, the local computer network or via the Internet.

With DialDictate you can dictate using most telephones. For example, you could dictate using 
a hands-free speakerphone or a cordless headset in your office, your car phone on the way to 
a meeting, your cell phone while you walk to work or even a payphone overseas.

Features  

● Supports 1 to 64 telephone lines.
● Controls include record, play, rewind (constant pitch), fast-forward (constant pitch) and 

record edit.
● Ability to send dictation recordings by email, local area network or internet.
● Recordings can be saved and retrieved at a later date for amendment.
● Uses the Audio Compression Manager to reduce audio file size and to speed transmission.
● Supports encryption of recordings for additional security and to comply with privacy laws.
● Up to 10,000 different users can use the one system each with customizable recipient and 

user information.
● When used with the free Express Scribe Transcriber, your typist can transcribe with 

footpedal control and variable speed playback.
● Connects to the telephone with either voice modems, professional telephony hardware or 

using Voice Over IP (VoIP).
● Fast setup and easy operation for day to day use.
● Easily customize the voice prompts to your own local requirements.

System Requirements  

● Windows 2000/XP/2003/Vista/2008/7
●  Either 

1.  A TAPI compliant telephony device *. 
2.  A VoIP (SIP) telephone service (no hardware required) **. 

● The telephone that you use must have tone dialing (DTMF).

* If you are connecting to 'real' telephone lines, DialDictate requires a TAPI compliant 
telephony device. Some voice modems are suitable but for professional use we recommend 
good quality voice devices listed on www.nch.com.au/ivm/modems.html. If you use a cheap 
voice modem you may find small buffering delays or other problems. For more information see: 
Voice Modems

. 

** If you signup for VoIP (SIP) telephone lines with any company which offers VoIP lines no 
special hardware is necessary. All you need is a broadband internet connection. See 
www.nch.com.au/talk/sip.html
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 for a list of recommended VoIP telephony companies and services. 

Note: If you do not yet have a suitable telephony device, you can test DialDictate using the 
Call Test Simulator

. 

The person who transcribes the recordings must also install Express Scribe (which is free) to 
unpack and decode the audio. Express Scribe also features foot pedal control and variable 
speed playback to assist with transcription. Download Express Scribe from 
www.nch.com.au/scribe

. 

When DialDictate is installed, a default demonstration user is set up. You can use this user for 
testing DialDictate. The default access code is 0. If you don't have telephony hardware yet, use 
the using the Call Test Simulator. 

DialDictate is free for evaluation only. To use DialDictate professionally either each user must 
also purchase an Express Dictate license or a DialDictate Site Installation License must be 
purchased. For more information, please see 
Purchasing and Registering DialDictate Software Licenses

. 

If you are looking for similar more specialised application, NCH Swift Sound makes related 
software for specific applications including...

Express Dictate is a desktop recorder which works like a Dictaphone. It can record your 
dictation directly or "dock" recordings from a dictaphone or other similar devices then send it to 
your typist over your computer network or via the internet. 

Pocket Dictate is software that runs on your Pocket PC PDA to record dictation. You record on 
your Pocket PC using the buttons on the unit then tap send to send the dictation to your typist 
by email. 

Other dictation software software ... Other software in the AudioAction range are available 
online. Some are free. 

Next:

Install, Set up and Run DialDictate or

Quick Start Guide and Tutorial 
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Contents - Install, Set Up and Run DialDictate

Installing DialDictate 

CD-ROM: If you have DialDictate on CD-ROM, simply insert the CD into the CD-ROM drive, 
loading should start automatically in about 10 seconds. If loading does not start automatically 
after 10 seconds, you may need to run the file DDSETUP.EXE on your CD-ROM drive using 
Windows Explorer. 

Internet Download : You can download DialDictate from www.nch.com.au/dialdictate . Click on 
the download file link and save the download file ddsetup.exe (DO NOT RENAME THE FILE). 
Once download is complete, run the file ddsetup.exe. 

1.4MB Disk: Click START then Run then enter A:SETUP and click OK. 

[Windows 2000/XP/2003]: You need to be logged in as an administrator to install software 
using Windows 2000/XP/2003.

Running DialDictate 

Once installation is complete, DialDictate will be running. By default, DialDictate will be set to 
run automatically when the system starts. You can change this using the DialDictate Run Mode 
on General Settings. 

While it is running, you can open DialDictate at any time by clicking on the DialDictate icon on 
the task bar tray.

To open DialDictate when it is not running, double click on the DialDictate icon on your desktop.

Testing DialDictate  

When DialDictate is installed, a default demonstration user is set up. You can use this user for 
testing DialDictate. The access code is 0. If you do not have telephony hardware yet, use the 
using the Call Test Simulator. 

If your do have telephony hardware or a voice modem but is does not seem to work correctly, 
see Troubleshooting Problems. 

Next:

General Settings 
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Contents - Troubleshooting Problems

DialDictate does not answer calls  

1. Have you added your telephony devices using General Settings?
2. Is some other software using the modem or telephony line device?
3. If you are attempting to use a modem, is it a true voice modem?

If none of the above solves your problem, please see Voice Modems and Telephony Devices  
for some hardware related tips. 

DialDictate answers the call but does not play a message 

1. If you are attempting to use a modem, is your modem a true voice modem?
2. If you are attempting to use a Dialogic Telephony Card, have you installed the Wave 

drivers (in addition to the TAPI drivers)?

If none of the above solves your problem, please see Voice Modems and Telephony Devices . 

No Line Devices appear when you Add a line device in Settings  

If you do not see a device, your TAPI drivers have either not been installed or have failed. For 
more information, please see: Voice Modems and Telephony Devices . 

Call hangs-up mid message or during recording 

This can happen when the hardware is misdetecting the end-of-call tone during playback or 
recording. If it happens during playback, turn off the "Enable end-of-tone detection during 
playback" option using the "Advanced Line Settings" from the General tab of Settings. If it only 
happens during recording, turn on the "Enable end-of-tone detection during playback" option 
but turn off the "Enable software based end-of-call detection" option.

Recording does not stop when the caller hangs-up  

If you have end-of-call tones on your line check you have turned on the "Enable end-of-tone 
detection during playback" option using the "End of Call Tone Detection Settings" from the 
General tab of Settings.

If your line has silence at the end of calls increase the Record Detect Level a little.

The audio quality is poor 

The audio quality is determined by the modem. Some voice modems offer only very poor 
quality voice.

If audio quality is important, you should consider purchasing a professional telephony card. 
See Telephony Hardware for suitable cards. 

Problems when sending emails 

See www.nch.com.au/kb/10006.html  for solutions to automated email problems. 
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General Dictation Problems 

If users complain that files go missing unexplained record overs or similar problems first view 
the log files File -> View or Print Logs to see what might have happened. Most often the 
problem is because the caller is not using the system correctly and is resolved by careful 
training (and the Caller's User Guide).

However it may be symptomatic of a more serious underlying hardware problem. Try to repeat 
the problem yourself and if the error repeats contact our technical support department (below).

If none of the above solves your problem, please contact our support staff following the 
instructions listed at www.nch.com.au/dialdictate/support.html . 
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Contents - Purchasing and Registering DialDictate

DialDictate is free for evaluation use only.

In order to use DialDictate there are 2 alternative licensing options:

1.  

Purchase Individual User Licenses

With this option you purchase an Express Dictate / DialDictate user license for each 
individual software user. The Express Dictate User license includes a license for the user to 
use the related software Express Dictate free. Note with this option that if you want to 
change email address, you will need to purchase another registration. 

This option is suitable for smaller transcription services with less than 20 users.

To view pricing or purchase a user license online please use this page: 
www.nch.com.au/express/register

. Once you have received a user registration use the 
menu to select File -> Register New User and enter the user details exactly as they appear 
on the registration. 

A user registration will also let the user use the related Express Dictate computer recorder 
software. You can download Express Dictate from www.nch.com.au/express. The same 
registration code can be used to register Express Dictate. 

2.  Purchase a DialDictate Site Installation License

When you purchase a site license you license the single installation of DialDictate for 
unlimited use. For the licensed installation you can add as many users as required without 
any further charge. 

This option is suitable to larger transcription services with more than 10 user (or anticipated 
users).

To view pricing or purchase a DialDictate site license online please use this page: 
www.nch.com.au/express/register

. Once you have received a site registration use the menu to 
select File -> Register Site License and enter your business details exactly as they appear on 
the registration. 

Once you have installed a site license you should backup the DialDictate folder because the 
key is a once off key that locks to your install folder (to protect against piracy). If you do not do 
this your key may not work if you have to download a copy of a future version of DialDictate.

When you have entered a valid Site License Key, you will be able to "Register New User" 
without purchasing a user key. You will need to enter an arbitrary but unique ID number (make 
them for yourself in sequence) when using Register New User but a key is not required.
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WARNING. Please be honest. It is both fraud and breach of copyright (piracy) to use a user 
license of another person. If we discover a person doing this we will report the matter to the 
police and, if the user belongs to a medical or legal professional ethical organization, we will 
file a copy of that report with the organization for unprofessional conduct. 

See also:

DialDictate License Terms 
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Quick Start Quide - Quick Start Guide and Tutorial

this is a place holder for the real quick.html in quickstartguide/quickstart.html 
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Quick Start Quide - Quick Start Guide and Tutorial - 
Stage A

STAGE A - Installing and Basic Test of DialDictate 

1.  Print the DialDictate Caller's User Guide . On the Explorer bar (the list of options on the 
left) select the option 'Print Callers User Guide'. You can also access through the User 
Settings (click on the Settings icon on the toolbar).  

2.  Test DialDictate using the Call Simulator . Click on the "Call Simulator" button and then 
"Connect Call". Follow the Caller's User Guide for instructions. The Default Access code 
for the Test User is 0#. Record and send a message. At this stage your recordings will go 
nowhere (they will be archived in the backup folder) until you set up the "User's Send 
Settings" (next step).  

3.  Set up the User's Send Settings. This tells DialDictate where and how to send recordings. 
From the menu select Options -> User Options then click the Settings button. Click on the 
"Send" tab. For this exercise we recommend you use a folder on you computer (pretending 
that it is the typists folder on the network). If you need to create a folder use Windows 
Explorer to do so. From the Send tab of User Settings tick the "Send to Network Folder 
(LAN)", browse to the folder and click OK -> OK to close all the user settings boxes.  

4.  Use the Call Simulator to record and send another file . See step 2.  
5.  Install Express Scribe. Download and install Express Scribe onto the same computer from 

www.nch.com.au/scribe
.  

6.  Load your dictation with Express Scribe. Open Express Scribe and select File -> Load 
Dictation file. Browse to the folder to which the dictation was dispatched and load the 
dictation into Express Scribe. Now select the dictation in the main window of Express 
Scribe and press Play. You should now hear your dictation being replayed to you. 

If you have had any problems with these steps so far refer to the manual for more information 
(Help -> Help Contents) including information on how to request technical support from us. If 
you have achieved success so far then pour yourself a cup of coffee before you move on to 
stage B.

See also:

Quick Start Guide and Tutorial - Stage B 

Call Test Simulator

Quick Start Guide and Tutorial 
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Quick Start Quide - Quick Start Guide and Tutorial - 
Stage B

STAGE B - Setting up telephony lines (land-line or VoIP telephone lines) 

In order to connect DialDictate to a land-line telephone number you will need either a CAHTA 
professional telephony board or a TAPI compliant telephony device, such as CURL TAPI 
boards, or even a standard voice modem. For professional applications we recommend 
multi-line telephony boards (eg. CAHTA or CURL). See www.nch.com.au/ivm/modems.html for 
current recommendations. 

Otherwise just sign up with a VoIP telephone company for a local VoIP line capable service 
(see www.nch.com.au/talk/sip.html for recommendations). 

With VoIP no special hardware is necessary, as DialDictate connects directly to the telephone 
exchange using your broadband internet connection. 

1.  [Real Line with Telephony Hardware] Check voice modem / telephony device is listed. 
From the DialDictate menu select Settings -> General Settings. See that your voice 
modem(s) or telephony card line(s) are listed in the Telephony Line Devices list. If it is not 
listed check you have installed the voice modem or voice board correctly (including 
drivers). If you have there may be a problem with the hardware's TAPI / Wave drivers. See 
www.nch.com.au/ivm/modems.html

 for solutions and more information.  
2.  [VoIP Lines] Enter VoIP details . After you have the number, password and SIP server 

from your VoIP company, select Settings -> VoIP. Click 'Add' and enter the VoIP Line 
Details.  

3.  Dial your number. Dial the number of the telephone line the modem / voice board is 
connected to. If your voice modem or telephony board and drivers are working properly 
then the response should be similar to when using the call simulator. If it does not answer 
or there are problems see www.nch.com.au/ivm/modems.html.  

4.  Record and Send a Dictation. Use the "Caller's User Guide" which you printed off earlier 
to leave a dictation. Now hang up and use see if you can find the dictation using Express 
Scribe. Always start with a short dictation. If there are response problems see the modem 
page above. 

See also:

Quick Start Guide and Tutorial - Stage C 

Professional Telephony Cards

VoIP Telephone Lines

Quick Start Guide and Tutorial 
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Quick Start Quide - Quick Start Guide and Tutorial - 
Stage C

STAGE C - Adding New Users 

Registering the User 

DialDictate can either be registered for the whole site using the DialDictate Site License from 
www.nch.com.au/express/register

, which covers all the DialDictate users or registered on a 
per user basis. With the site license users may be added as they are required. 
If you are registering on a per user basis, you must purchase a Express/Dial/Web/Pocket 
Dictate Professional Single User license at www.nch.com.au/express/register  for each 
DialDictate user added to the system. When you have received your DialDictate User 
Registration, click on the Add button from the User List. Then enter the user's name and email 
address exactly as it appears on the registration. 

You can now change the various user settings.

Reducing Audio File Size.  

Audio files can be very large. "Audio Compression" is used to reduce the size of a file. 
Remember that the more compression that is used the worse the resulting file quality so using 
compression is a trade off between quality and file size. Different compression formats can be 
compared at www.nch.com.au/acm. These compression formats are called "codecs". You 
should always select a codec that is also installed on the typist's computer. The codecs that 
are installed on a computer can normally be viewed in control panel/multimedia 
properties/devices/audio compression codecs (or a similar folder). 

1.  Set Audio Compression Format For Sending . Using the menu open General Settings -> 
Options -> Set Audio Compression Format For Sending. The recommended setting is 
GSM6.10. 

2.  Prepare and dispatch another dictation. See if this dictation can be loaded into Express 
Scribe on the typist's computer. 

Changing the Send Method 

Decide how the audio file will be dispatched from the DialDictate computer to the typist's 
computer. 

There are generally 3 options: 

1. Sending over your computer network LAN (the easiest). This includes the situation when 
DialDictate and Express Scribe are on the same computer.

2. Sending by email (this is useful where the typist works remotely).
3. Uploading to an FTP server (most complex but also powerful in large organizations).

See the reference manual for more information about these options. 

Sending the user's dictations to the typist 
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1.  Install Express Scribe on the typist's computer. See step 5 in 
Quick Start Guide and Tutorial - Stage A

. 
2.  Change the Send Method. Use the User Settings -> Send tab. 
3.  Prepare and dispatch another dictation. See if this dictation can be loaded into Express 

Scribe on the typist's computer. 
4. Now set Express Scribe on the typist's computer to automatically scan for incoming 

dictations (from Express Scribe use Settings -> Incoming).

That is it! You have completed the exercise and are ready to use DialDictate referring to the 
reference manual (Help -> Help Contents) for more advanced options.

Our tip to all beginners is start with short dictations - if you want to dictate a long item break it 
up into short parts and send them individually. Do not do a 15 minute dictation in one file until 
you have used DialDictate for a while and are confident about using it.

Once you are satisfied that DialDictate is suitable for your requirements please do purchase a 
user license for each user as required by the license terms. To purchase a license for a user 
online, please use this page: www.nch.com.au/express/register . 

See also:

Quick Start Guide and Tutorial 
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User's Guide - Caller's User Guide

This is a guide for DialDictate users. Please print this page and give it to each person who 
uses DialDictate to dictate by phone.

To access DialDictate dial: ___________________

Your Access Code is: ___________________#

Introduction 

If you are new to DialDictate, you will need to take time to learn how to dictate via telephone. 
There is a good chance you have worked with your portable recorder for many years and have 
become very familiar with its operation. Do not expect to do the same with DialDictate with your 
first call. Start with short and simple recordings. With time you will become more confident.

Entering Your Access Code 

When DialDictate answers your call, enter your access code followed by the #  key. If you 
make a mistake while entering you access code, press the * key to start again. 

Main Menu 

The options at the main menu are:

1  Record a new dictation (see Recording Mode below).

2  Open a previously saved dictation (see Opening Dictations below).

9  End the call. 

If your DialDictate administrator has selected this feature, when you first record a new dictation 
you may be prompted to enter a reference number (eg. patient or case number). If prompted 
enter the reference number followed by the #  key. If you make a mistake press * to start again. 
If a reference number is not applicable to the recording just press # . 

Recording Mode 

The record controls are:

1  Go to the dictation start  and begin play.

3  Go to the dictation end.

4  Rewind.

5  Review (step back 5 seconds and play).
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6  Fast-Forward.

7  Play  from current position.

9  Record from current position.

0  Stop.

* Done (see Done Menu below). 

If you ever don't know where you are in the recording, press 3  to go to the end of a recording. 

If you are silent for more than 20 seconds, DialDictate will automatically stop. If there is no 
activity after a further 60 seconds, DialDictate will hang-up. Press 0  regularly to keep the line 
active. 

We recommend that you break long dictations into a series of shorter dictations because it is 
easy to get lost in longer dictations on the telephone. Breaking your recordings also means 
your typist can begin typing sooner. If you do need to type longer dictations, you will find that at 
the Record Stop Interval DialDictate will say "Stopped" and you will need to press 9  to 
continue dictating. This is needed so DialDictate can confirm that you actually are continuing to 
dictate to avoid a run-on situation. 

Remember to send your files (*1) and disconnect (9 ) before hanging up. 

You don't have to wait for the menu prompt to finish before pressing 9  to start recording. 

Done Menu 

When you press * after recording, you will have these options:

1  Send the file for transcription.

2  Save the file for later further recording.

4  Delete  the file.

5  Send the file for transcription with high priority. 

All of these options will return you to the Main Menu (above).

Opening Dictations 

If you select option 2  (Open Dictation) from the Main Menu, 5 seconds of the start of each 
previously saved recording will be played. You can then select one of the following options:

1  Send file now.

3  Open file. You will then be in Recording Mode (see above) at the recording end.
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4  Delete file.

5  Send the file for transcription with high priority.

6  Next file.

* Return to Main Menu (above). 

Please always exit the system correctly (via the end (9 ) command on the Main Menu). 
Otherwise you can lock the line out for other callers for 60 seconds. 

DialDictate

(c) NCH Swift Sound

www.nch.com.au/dialdictate  
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Screen References - Advanced Recording Options

Automatic Recording

The recording can be automatically started when either the Record Control dialog is opened or 
when the audio to be recorded reaches the threshold level. Additionally any quiet periods at 
the start and the end of the recording that is below the threshold level can be trimmed.

Auto Start Recording

The recording will automatically start when the Record Control dialog is opened, you will not 
need to select the record button.

Auto Trim Recording

Trim the recording to remove any quiet periods from the start and ending of the recording. Use 
the threshold slider to specify the cutoff level.Voice Activated Recording

Automatically start the recording when the audio level reaches the threshold.

Threshold:

Use the slider to set the threshold level for the recording. Used for both the auto trim and the 
voice activated start.
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Screen References - Enter Administrator Password

DialDictate is currently protected by an Administrator password.

Please enter the Administrator password to open Dial Dictate.
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Screen References - Password Change Confirmation

The password has changed, please re-enter the Administrator password to confirm the new 
password.
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Screen References - Call Simulator

You can test DialDictate without actually making a call, using the Call Test Simulator.

To run the Call Test Simulator, select the "Call Test Simulator" item from the File menu.

The Call Simulator works almost exactly the same as a normal call.

You may notice some differences in audio quality and response times (the Call Simulator is 
faster) when compared to a real call.

If you have problems attempting to record with the Call Simulator, you should check that you 
have a microphone plugged into the sound card of your computer and that the Sound Record 
Mixer has the microphone turned on.
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Screen References - New User (Site License)

Registering a New User with a Site Licensed DialDictate.

There are an unlimited number of users available for a Site Licensed DialDictate.

Fill in the following fields:

●  User Name

The user's name, this will be display to the typist when the dictations are opened with 
Express Scribe.

●  Email

Enter the user's email address. This will be displayed to the typist when the 
dictations are opened with Express Scribe.

●  ID

Enter an unique ID number (six digits or less) for the user. This number will be 
permanently assigned to this user and is used to uniquely identify the user to 
DialDictate.
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Screen References - Register New User

Purchase Individual User Licenses.

With this option you purchase a DialDictate user license for each individual software user. Note 
that with this option if you want to change the email address, you will need to purchase another 
registration as the user registration is linked to their email address. 

How to Purchase

Purchasing and Registering a new DialDictate User License is an easy process that involves 3 
simple steps:

1. Purchase: Purchase a license using your credit card. You will be supplied with an 11 digit 
serial number on the screen and by email. This is your license serial number.

2.  Activate: Use this number at: www.nch.com.au/activate to convert the 11 digit serial 
number into a registration containing 4 fields - Name, location or email, ID and key. This is 
your registration and activation code. 

3. Register:  Insert these details into your software from the DialDictate menu and select 
Register New User. This process will normally convert the demo version of the software 
into a professional version. If you do not receive an error message then it means that the 
details have been accepted.

See also:

Purchasing and Registering DialDictate 
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Screen References - Advanced Access Code Settings

The Advanced Access Code options allow the choice of where the Access Code for a user is 
stored.

1.   Use the Access Code specified in User Settings 

This choice simply uses the Access Code as entered on the User Settings ~ User page. 

2.   Access Code stored in a database 

This choice allows the use of an ODBC database lookup to retrieve the Access Code for 
the user.

To successfully retrieve the Access Code value from the database the following fields must 
be defined:

●  Database Data Source Name (DSN) 

The DSN the specifies the database to connect to. (Note: This must be a System 
DSN.)

●  Database User Name 

The database user account name to use to connect to the database.
●  Database Password  

The password for the database user account.
●  Database table 

Look up this database table for the Dictator ID.
●  Column to match Access Code 

The database column that contains the Access Code.
●  Column to return Dictator ID 

The column containing the Dictator ID to return.

These values will be used to create a query in the form:

SELECT Dictator ID FROM Table WHERE Access Code = 'access code value' 

Use the [Test ] button to test the database connection and that the expected value is 
returned from the database query. 
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For more go to Database Test. 

Restore 

The [Restore] button will set the option to Use the Access Code specified in User Settings and 
clear all other fields on this page. 

See also:

User Settings ~ User

Settings 
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Screen References - Database Test

Access Code to test 

Enter a known Access Code to test that the Dictator ID is successfully returned from the 
database.

Use The [Try Database Query] button to execute the database query. 

Information about the success of the database query will be shown in the text panel below the 
[Try Database Query] button. 

See also:

Advanced Access Code Settings

Settings 
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Screen References - Callers User Guide

The Callers Guide gives a step-by-step guide to using Dial Dictate from the telephone. 

How do you wish to view The Guide

Choose the way that the guide will be viewed.View it now

Display the Caller Guide in a Web browser.

Print it

Prints the Caller Guide to your default printer.

Email to the user

Email the Caller Guide to the users registered email address.

Copy to clipboard

Copy the Caller Guide into the Windows Clipboard so you can use it in another application.

Phone Number the User calls to access Dial Dictate 

This is the telephone number the user calls to access Dial Dictate.
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Screen References - Valid Dictation Types

After the caller creates a new dictation they can be prompted to enter a number that 
corresponds to the dictation type. This number is then displayed to the typist (with Express 
Scribe) or dictation management software (eg. Express Delegate).

Validate Dictation type

If this option is ticked, after the caller enters the dictation type number a lookup for the number 
in this list will be performed. If the entered number is not in the list then the caller will be 
prompted to enter the dictation type number again. Dial Dictate will not allow the caller to 
record a dictation until they have supplied a valid dictation number. 

Add Dictation Type

Add a new Dictation Type. See Add Dictation Type 

Edit Dictation Type

Edit an existing Dictation Type. See Add Dictation Type 

Delete Dictation Type

Remove the selected Dictation Type.

See also:

Settings - Options

Settings 
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Screen References - Add Dictation Type

Add a new Dictation Type

After the caller creates a new dictation they will be prompted to enter a number that 
corresponds to the dictation type. This number is then displayed to the typist (with Express 
Scribe) or dictation management software (eg. Express Delegate).

Dictation Type

Enter a number that the caller will need to enter when they are creating a new dictation.

Description

A simple description for this Dictation Type. This will not normally be seen by either the caller 
or the typist.
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Screen References - User Settings ~ User

User - User Enabled  

The user may be disabled or bared from connecting to the system be un-ticking the User 
Enabled option.

This is an easy way to stop a user from using Dial Dictate without deleting their entry. 

The user may then be reactivated be ticking the option.

User - User Name 

User's name, this can only be changed when using a site license as it is linked to the user's 
registration. 

User - DialDictate Access Code (PIN)  

The DialDictate Access Code is the PIN code the user dials to identify themself to DialDictate. 
This should not be confused with their Dictator ID which identifies the user within the system, 
this can not be changed. The Access Code can be changed at anytime and should be treated 
as a password.

The Access codes can be either stored within DialDictate or retrieved from an ODBC enabled 
database, see the User Access Code on Options ~ Users. When using DialDictate to store the 
Access Codes, DialDictate will check that the entered Access Code is unique across all of the 
users and will prompt you to use another code if it is already in use. If DialDictate is retrieving 
the Access Codes from a database, you should make sure that the database enforces 
uniqueness for them.

Note: DialDictate versions prior to version 4.09 did not enforce uniqueness of the Access Code 
when they were saved. So, if the system has been upgraded from a version prior to 4.09 
please check that all of the saved Access Codes are unique.

User - Advanced 

This button gives access to advanced choices for the source of the Access Code, such as a 
database.

For more go to Advanced Access Code Settings. 

User - Automatic Answer for Caller ID 

DialDictate can be set to automatically skip the need to enter an access code if a call comes in 
with the caller ID for the user's phone. Often this is for cell phone use. To use this enter the 
number in this field.

Note: This option requires you hardware to support caller number ID detection and for your 
telephone company to carry the information. Check the log files for caller ID numbers to see if 
your hardware supports this.

User - Status 
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The Status area displays the recorded values for the user.

These values include: 

●   Dictator ID  

The ID assigned to this user.
●   Last Access Date  

The last date that this user has used Dial Dictate.
●   Total Dictation Time  

The accumulated time in seconds that this user has recorded in dictations. This 
value may be reset to zero by using the Clear Values button. 

●   Total Time On-Line  

The accumulated time in seconds that this user has been connected to Dial Dictate. 
This value may be reset to zero by using the Clear Values button. 

●   Clear Values 

The Clear Values button will reset the  Total Dictation Time  and  Total Time On-Line  
values back to zero.

If the values are ever cleared then the date that this was last done will be displayed in the 
State area with the label  Last Cleared . 

See also:

User Settings ~ Send Method

User Settings ~ Dictation

User Settings ~ Details

Settings 
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Screen References - User Settings ~ Send Method

Note: All dictations are copied to the backup folder after they've been sent.

Send Method 
For each user, you can select how the dictation will be sent.

●  None:

The dictation will not be sent.

●   Express Delegate: 

Express Delegate (v4.00 or above) is a dedicated dictation workflow management 
server. It offers several advantages over other send methods, such as the ability to 
automatically assign typing tasks to members of typing pools based on customizable 
rules and criteria. 

The Express Delegate server can be a computer that is accessible across a LAN (local 
area network) or the internet. The Express Delegate administrator will need to create an 
account before you can logon to the server. Please consult the Express Delegate help 
for more information on installing Express Delegate, configuring the server, and creating 
user accounts. 

●   FTP: 

Send dictations directly to an FTP (File Transfer Protocol) server. Note that you must 
have your own directory on this server. You do not need to host your own server - 
almost all ISP web hosting services offer FTP access which is suitable and very 
affordable, and the server can be located anywhere in the world. NCH Software 
provides a list of recommended FTP hosting services here. 

●   Email: 

If you select this option, the recipient will be sent the dictation as a file attached to an 
email. 

●   Local Folder: 

If your typist is in your own office the fastest way to send typing to them is over your 
LAN (local area network). For this, your typist must have a share folder on the network - 
if necessary ask your systems administrator to create a suitable folder. 

Alternatively, this option can be used for writing dictations to a removable media such as 
a USB memory device or a floppy disk. 

Express Delegate Options 
Server 
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●   Address: 

eg. server.company.com 

●   Port 

The server port number. 

●   Secure connection (SSL/TLS) 

Check this check-box to encrypt data transfers to and from the server. 

Logon 

●   Email address / password: 

The Express Delegate user account logon email and password. Please consult the 
Express Delegate help for information about how to reset your password if you have 
lost it. 

●   Test connection: 

Click to attempt a connection to the server using the current server and logon details. If 
the connection is successful then details of the server will also be shown. 

FTP Options 

●   Server: 

eg. ftp.company.com (or ftp.company.com:12345 to specify a non-default port number). 

●   Secure Connection (FTPES): 

Check this check-box to encrypt data transfers to and from the server, if the server is 
capable of doing so. 

●  Logon type:

Select whether to use a user account or log on anonymously.

●   User Name / Password (if logon type is not anonymous): 

The FTP account name and password. 
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●   Folder: 

A sub-folder of the default FTP server folder. 

eg. /typing 

Leave this field blank to use the default folder. 

●   Test connection: 

Click to attempt a connection to the server using the current server and logon details. 

Email Options 

●   Destination email address: 

The email address of the typist. 

●   Email settings...: 

Click this button to select between the available email protocols (eg. MAPI or SMTP), 
and configure server and log-in details. 

●   Test email: 

Enter an email address and click "Send test email..." to test the email settings. 

If the test email doesn't arrive, or an error is reported, please refer to 
Problems when sending email using our software

 for trouble-shooting information. 

Local Folder Options  

●   Destination Folder or Drive: 

A shared network folder (eg. "H:\Shared\Typing\My Typist"), or the local drive letter of a 
removable storage device (eg. "E:\"). 

See also:

User Settings ~ User

User Settings ~ Dictation

User Settings ~ Details
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Settings 
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Screen References - User Settings ~ Dictation

File Format 

By default DialDictate sends file in the dictation (DCT) file format. A dictation file contains the 
recording and other information such as priority, sender information, reference numbers and 
can be encrypted. You can open DCT files with the free Express Scribe software (
www.nch.com.au/scribe

) or Express Delegate or ETOOLS. 

Alternatively DialDictate can use the wave (WAV) format if you want to open recordings with 
software that cannot open the DCT file format. But take care because WAV files neither 
contain sender information nor can be encrypted.

The file format must be DCT when "Express Delegate" is selected as the send method.

File name 

You can specify the format of the file names used for sending. The file name contains text with 
a number of optional variables (variables are circumfixed with %name%).

Variables you can use include:

●  %userid% - the numeric ID of the dictator (used to ensure uniqueness) 
●  %filenumber% - the unique file number of the file (always include this in the file to 

make sure files are unique) 
●  %username% - the name of the dictator 
●  %usercompany% - the company of the dictator 
●  %filepriority% - set file priority in percent (default 50%) 
●  %ref% - any reference data entered 
●  %type% - any type data entered 
●  %YYYY%, %MM%, %DD%, %HH%, %MIN%, %SS% - time of sending (year, 

month, day, hour, minute and second respectively) 

The default file name format is: dd%userid%-%filenumber% (%username%)

Encryption 

Recordings can be encrypted for increased security and to comply with privacy laws. To use 
strong encryption, tick the "Encrypt recordings for additional security" box and enter the key. 
The key can be 1 to 50 characters. Your typist will need to have the same key to decode the 
file entered into Express Scribe.

In order to use encryption, you must select the "DCT" file format option. 

Please note that the "Demo Test User", Dictator ID = 0, does not allow encryption to be turned 
on. If you wish to test encryption please add a new user and set their encryption key.
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Encryption cannot be enabled when "Express Delegate" is selected as the send method. To 
encrypt transfers to Express Delegate, check the "Secure connection" check-box in "Express 
Delegate options". 

Backup Folder 

Click "Open Backup Folder..." to view the contents of the dictation backup folder. 

This folder contains a copy of all the dictations that have been completed.

For more about the Backup Folder see the Settings ~ General page. 

See also:

User Settings ~ User

User Settings ~ Send Method

User Settings ~ Details

Settings 
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Screen References - User Settings ~ Details

Each user can have details about themselves stored which the typist will be able to view by 
using Express Scribe.

Detail items: 

●  Company

Company name.
●  Email

User's email address, this can only be changed when using a site license. 
●  Phone

Contact telephone number.
●  Cell/Page

Cell/Mobile phone or Pager number.
●  Fax

Facsimile number.
●  Address

Address, up to 4 lines.

Note: 
When not using a site license you cannot change the user's name or email address as 
these are linked to the user's registration.

If you want to change the email address, you will need to purchase another registration.

For more about licenses, see Purchasing and Registering DialDictate. 

See also:

User Settings ~ User

User Settings ~ Send Method

User Settings ~ Dictation
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Settings 
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Screen References - Options

To open the Options dialog box, select the Options menu item from the Main Window.

Settings Tabs

●  General 
●  Options  
●  Telephony 
●  Users 
●  Voice Prompts 
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Screen References - Options ~ General

Startup Run Mode

Dial Dictate can be configured to run automatically either on computer system startup, as a 
service, or whenever a user logs on to the computer. 

●  Run Dial Dictate automatically as tray icon on system startup Tick this option if you want 
this program to run automatically when the computer starts (or you logon).

Select the run mode from the list of options available.

● Run when any user logs on
● Run when this user logs on only
● Run as Service (before logon). Show all users
● Run as Service (before logon). Show this user only
● Run as Service. Do not show to users

●  Service Settings 
Click the [Service Settings] button to customize the settings used when Dial Dictate is 
running as a service. 

Password required to operate DialDictate

You can set a password to prevent others from being able to open DialDictate. When this 
option is enabled you must enter the Administrator password to get access to the DialDictate 
menus. 

●  Enable Administrator password Tick this option to enable password protection for 
accessing DialDictate.

Enter the desired password, then re-enter the same password to confirm it.

Dictation backups

The Dictation Backup Folder contains a copy of all dictations that have been successfully sent 
to their destinations.

Whenever DialDictate sends a file, it makes a backup copy of that file in the Backup folder. In 
case the typist loses a dictation, you can recover and resend the file from the backup folder.

●  Backup Folder  Displays the currently selected Backup Folder. 

Use the [Browse...] button to select a new folder to use as the Backup Folder.

Use the [Default ] button to reset the selected folder back to the default setting. 
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●  Autodelete backup files after (number of days): 
Enter the number of days to keep the backup dictation for.

In order to stop the hard drive filling up with old recording DialDictate will automatically 
delete old files after a set number of days. The default settings is 30 days. A setting of 0 
disables the auto-delete function (files will need to be deleted manually).

●  Open Backup Folder 
Click the [Open Backup Folder] button to view the contents of the dictation backup folder. 

See also:

Settings 
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Screen References - Options ~ Options

Prompt for reference number 

If this option is ticked, when the caller creates a new dictation they will be prompted to enter a 
reference number followed by #. The reference number will then be displayed as part of the 
notes field on Express Scribe (www.nch.com.au/scribe), Express Delegate 
www.nch.com.au/delegate

 or extracted using ETOOLS www.nch.com.au/etools. 

This can be used where for example a Doctor needs to provide a patient number, case file 
number etc.

●  

Read out entered reference number

Tick this option to have Dial Dictate repeat the entered reference number with the option for 
the caller to change the value.

Prompt for dictation type 

If this option is ticked, after the caller creates a new dictation they will be prompted to enter a 
number that corresponds to the dictation type. This number is then displayed to the typist (with 
Express Scribe) or dictation management software (eg. Express Delegate).

The entered dictation type number can be validated against a list of known dictation types. To 
set up the list of numbers to validate against click the [Valid Dictation Types] button. 

See Valid Dictation Types. 

Read out internal dictation number when sending  

When this option is ticked DialDictate reads out a dictation number. This is the internal file 
number used by DialDictate (and should not be confused with the reference number above). 
The number will be part of the name of the sent file so it can be used to audit or track dictations.

Send files if caller disconnects without saving 

A well behaved caller should always send file properly (*1) before ending the call (9). But often 
callers just hang up where they stop.

If this option is ticked, files will automatically be sent if the caller hangs-up while recording. If 
this option is not ticked, the recording will be saved but the caller will need to know to load it 
when they next call.

Skip the main menu if there are no saved dictations 

Then ticked when the caller connects (or after they send a file) and if they have no saved files, 
a new recording will be created automatically and they will be played the record menu.
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Take care with this option. If you use it there will not be an opportunity for the caller to 
disconnect 'gracefully'. That means they will just have to hang up to end the call. If the 
end-of-call tones are missed, the line may stay off hook for a couple of minutes until the menu 
times out.

Skip done menu 

When ticked, if the caller presses * when recording, the file will be sent immediately. They will 
not be given the option to save or delete the file.

Recording continuous auto-stop time 

In order to prevent DialDictate continuing to record when during recording the user has hung 
up 'badly' (ie. without end-of-call tone), DialDictate must limit the length of recording without 
user interaction. By default this is 7 1/2 minutes (450 seconds). If the caller records to 7 1/2 
minutes, they will hear the 'stopped' prompt and must push the record button again to continue 
recording.

The interval can be adjusted if required using this setting.

Stopped timeout before hangup 

Sometimes callers may hang-up while in stopped mode. In order to prevent DialDictate 
keeping the line off-hook indefinitely DialDictate has a timeout default 90 seconds in stopped 
mode. If the caller does not start dictating within this time the call will hang up. In order to keep 
the line open the caller should press '0' to give themselves more time.

Voice Activation Level  

DialDictate uses voice activated recording to stop recording when there is silence. DialDictate 
also tests for some hang-up conditions using this level. The default is -20dB. If recording 
continues over long periods of silence or does not hang up on silence, increase this level to 
-15dB. If recording is chopped, try reducing this level to -30dB.

Set Audio Compression Format For Sending  

If you are sending your recordings via the internet or email, you can reduce the file size using 
audio compression. Audio compression can dramatically reduce upload times but can also 
reduce audio quality.

To select a suitable record format, click on the [Set Audio Compression Format For Sending ] 
button. You must ensure that your typist running Express Scribe has the same codec that you 
select on their computer. The recommended codec is GSM 6.10 but see www.nch.com.au/acm
for a description of all compression formats and codecs. 

Change Record Menu Key Assignment 

The main record menu key assignment can be changed. Click on this button to open the 
assignment box.

We do not recommend changing the menu because the default menu used by DialDictate is a 
standard in the industry. If you modify the menu it may cause future problems when users 
move between systems. You will need to re-record the Record Menu voice prompt if you 
change the menu to reflect these changes.
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Advanced Email Send Settings 

If you use email to send recordings, you may to select the email delivery systems by using the [
Advanced Email Send Settings] button. 

DialDictate can send email in two ways:

1.  

Sending via a networked SMTP Server

This is the process where the email is sent using a SMTP server. The SMTP server usually 
is provided by your ISP. Its role is to relay emails for you. You do not require an installed 
email client.

2.  Sending Directly

When this option is selected the software sends the email directly to the remote persons 
email address. No outgoing server relays the email.

Note: An SMTP server option (above) is preferred. The problem with the direct method is that if 
the remote email server is down email will fail. SMTP servers normally queue or spool mail for 
12 hours.

See also:

Settings 
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Screen References - Options ~ Telephony

This is the list of all the telephone lines (PSTN and VoIP) currently configured for use.

They should include all voice modems or professional telephony devices as well as all of the 
VoIP lines that you wish to use. 

Add 
Add a new telephony line device or VoIP (SIP) line. See Telephony ~ Add Device. 

Remove  
Removes the selected line device from the configuration. 

Properties  
Change the properties of the selected line device. See VoIP Help - Account and 
Hardware Help - Line Properties

 for more. 

See also:

Settings 
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Screen References - Options ~ Users

Multiple users can use DialDictate and each has their own 'user settings' including name, 
access code, send method (typist) and other details. Open the Users List by clicking the "User 
Settings" button. 

User Access Code 

The DialDictate Access Code is the PIN code the user dials to identify themselves to 
DialDictate. 

The Access codes can either be stored within DialDictate or retrieved from an ODBC enabled 
database, see Advanced Access Code Settings. 

User List 

From the "Users List" you either Add a new user or select an existing user and click "Settings" 
to change their settings.

Users may be enabled / disabled by ticking / unticking the tick box next to each user.

When a user has been disabled they will not be allowed to use Dial Dictate. Their details 
remain intact, so they can be easily enabled again by ticking their enable option. 

User List Columns 

●  User Name

The User's Name. 
●  Last Access Date

The last date that this User has access DialDictate. If they have never used DialDictate 
then this will be blank. 

●  Diciation Time

The accumulated time, in seconds, that this user has recorded in dictations. 
●  Time On-Line

The accumulated time, in seconds, that this user has been connected to DialDictate. 

Users List - Add 

For each DialDictate user, you must purchase a Express Dictate / DialDictate user license at 
www.nch.com.au/express/register

. See that page for current pricing information. The Express 
Dictate registration unlocks the related computer dictation software, Express Dictate, and 
includes a unique user ID for use with DialDictate. 

When you have received your Express Dictate User Registration, click on the Add button from 
the User List. Then enter the user's name and email address exactly as it appears on the 
registration.
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Users List - Remove  

Permanently remove the selected user from DialDictate.

Users List - Settings 

Opens the User Settings dialog to view and edit the User's details.

Users List - View Guide 

View or print the User's Guide.

See also:

Settings 
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Screen References - Options ~ Voice Prompts

Voice Prompts

These are all of the voice prompts used by the system for feedback to the callers of DialDictate.

They can be easily customized for your own requirements by using the Change Voice Prompt  
option.

Please remember when your are changing any prompt to keep the meaning and intent of the 
original prompt to avoid confusion. 

Play Voice Prompt

This button will play the currently selected Voice Prompt.

Change Voice Prompt...

To change a prompt, select the prompt, click on the Change Voice Prompt button and then 
select one of the following menu items: 

●  Record

record from a sound source such as a microphone.
●  Load wav or mp3 file 

load an existing recording from a file.
●  Text-to-Speech synthesis 

synthesis speech from a piece of text.
●  Edit 

edit an existing sound file using WavePad. 
●  Reset to default prompt 

restore the prompt back to the original distributed prompt, copied from the Default Voice 
Prompts  folder in the DialDictate data folder. 

In order to use the Synthesize Text-to-Speech you must have a speech engine installed. 
These are free from Microsoft. Follow the link at http://www.nch.com.au/speech . 

See also:

Settings 
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